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Nominal Accounting Software 

Welcome to the Nominal Small Business Accounting Software User Manual.  Please take time to 
review this document and familiarise yourself with your new accounting software.  We hope 
you will enjoy using this tool and wish you good luck with your small business. 
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Introduction 

Nominal Accounting Software 

Nominal Accounting Software is easy-to-use yet fully featured.  It is the first accounting 
software to support Standard Business Reporting (SBR). 

Nominal Accounting Software has all the usual accounting features plus additional features that 
even more expensive softwares don’t have including: 

• BAS submission and TFN declaration using SBR 

• Payroll Management 

• Keyword Search 

• Inventory and Stock Management 

• Quote Creation 

• Customised Forms and Invoices 

• Portable Company File 

• Many Additional Features. 

Visit our website, www.Nominal.com.au to find out more or email us at info@Nominal.com.au. 

Some of Nominal Accounting Software’s features include: 

• Standard Business Reporting (SBR) using the new Australian Government interface for 
submission of quarterly BAS forms 

• Simple User Interface enabling faster performance of routine tasks 

• Quick Learning Ladder 

• Windows 7 Themes using a Microsoft Office Ribbon interface 

• Payroll function for managing employee salaries and payments 

• Basic inventory for buying and selling items 

• Bank Statement Import and Synchronisation. 

  

http://www.nominal.com.au/�
mailto:info@nominal.com.au�
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Using this Guide 

The Nominal Accounting Software User Guide was developed to help familiarise you with the 
software.  While we developed Nominal to be simple and intuitive, we acknowledge that our 
customers may need some assistance. 

This guide contains the following sections: 

• Introduction 

o This section provides an introduction to the software and SBR. 

• Getting Started 

o This section is a quick start guide to the software including the first steps you’ll 
take using the software. 

• Product Areas 

o This section provides detailed information about the different areas of the 
software including an overview of the screens, buttons and associated 
operations. 

• Reference 

o This section provides information about fields and shortcut keys. 
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Standard Business Reporting 

Nominal Accounting Software is registered with the Australian government and the ATO to 
supply Business Activity Statement (BAS) submission service online. 

The following is an extract from the SBR website, located here: 

http://www.sbr.gov.au/en/about_sbr/?page=8 

About SBR 

Current reporting requirements impose a significant burden on business – a business that the 
Australian government is committed to reducing. 

Standard Business Reporting (SBR) is an Australian government initiative to reduce the 
business-to-government reporting burden.  This major whole-of-government project 
streamlines business-to-government reporting through their SBR-enabled accounting/payroll 
software and will save businesses time and money.  Using SBR-enabled software will allow 
Australian businesses to prepare and lodge key government forms directly from their software 
to SBR partner agencies.  Businesses will need to register for an AUSkey which will allow them 
to send reports via SBR. 

Led by the Australian Treasury, the SBR partner agencies are the Australian Taxation Office 
(ATO), the Australian Securities and Investments Commission (ASIC), the Australian Prudential 
Regulation Authority (APRA), from July 2011, all State and Territorial Government Revenue 
Offices (ROs) and the Australian Bureau of Statistics (taxonomy only).  The Department of 
Innovation, Industry, Science and Research are providing trust broker services.  Some examples 
of reports SBR is targeting include the Business Activity Statement (Australian Taxation Office), 
financial statements (ASIC), and payroll tax returns (State and Territory Government revenue 
offices).  See the current forms in scope. 

SBR has been co-designed by Australian state and territory government agencies in partnership 
with software developers, business and their accountants, bookkeepers, tax agents and payroll 
professionals.  SBR is simplifying business-to-government reporting by: 

Removing unnecessary or duplicated information from government forms 

Using business software to automatically pre-fill forms 

Adopting a common reporting language, based on international standards and best practice 

Making financial reporting a by-product of natural business processes 

Providing an electronic interface to agencies directly from accounting software, which will also 
provide validation and confirm receipt of reports 

http://www.sbr.gov.au/en/about_sbr/?page=8�
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Providing a single secure online sign-on to all agencies involved for all users. 

SBR is expected to save Australian businesses an estimated $800 million per year once fully 
implemented.  Adoption of SBR will be voluntary and no legislative changes will occur as a 
direct result of the initiative. 
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Getting Started 

Getting started with Nominal is as easy as 1, 2, 3.  Use the following section to be off and 
running quickly. 

1. The Company Wizard opens the first time you open Nominal.  The Company Wizard enables 
you to create a new company file, open an existing file or load the last file used. 

2. After creating the company file, proceed to the Manage area to enter initial company data 
for your accounts, customers, employees, items and more. 

3. Start recording business transactions using Nominal. 
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Company Wizard 

 

 Feature Description 

1. New Company File Click the New Company File button to create a new Company Data File 
(CDF) and move to the second step in the Company Wizard. 

2. Open Company File Click the Open Company File button to open an existing CDF saved on 
your computer. 

3. Open Last File Click the Open Last File button to open the last CDF you used.  This 
option is not available the first time the software is used. 

4. Exit Click the Exit button to exit the software. 

  



Nominal Accounting Software 

 -8- September 2011 

Creating a New Company Data File 

The first step in using Nominal is creating a Company Data File (CDF). 

To create a new CDF, 

1. Click the New Company File button. 

 

The Company Wizard Step 2 screen opens. 
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2. Enter as much information as possible in the fields on the screen. 

NOTE:  This screen can be returned to and modified at a later time. 

Field Description 

Company Name Type the name of your company. 

ATO Category Choose the appropriate ATO Category from the dropdown field. 

ABN/ACN Type your company’s ABN/ACN in this field. 

Address Line 1 Type your company’s street address or PO Box. 

Address Line 2 Type your company’s Address Line 2. (Optional) 

Town/Suburb Type your company’s town or suburb. 

State Type your company’s state. 

Country Type your company’s country. 

Post Code Type your company’s post code. 

Phone Type your company’s phone number. 

Fax Type your company’s fax number. 

Email Address Type your accounting department’s email address. 

Website Address Type your company’s website address. 

Back button Click the Back button to return to the Company Wizard Step 1 screen. 

Voice Guide Controls Click the Stop, Play, Pause, Close (Current Guide), and Close (All 
Guides) buttons to control the accompanying voice guide. 

Next Click the Next button once you’ve filled out the fields satisfactorily. 

NOTE:  This information will be used in customer invoices so ensure that the information is 
accurate. 
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Once completed, the Step 2 form should look similar to this: 
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3. Click Next once you’ve entered the appropriate information.  The Predefined Accounts 
(Company Wizard Step 3) screen opens. 
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Click the plus sign next to Root Account to see the default account files folder structure.  This is 
generally referred to as the Chart of Accounts.  The default account files folder structure looks 
like this: 

 

The default folder structure organises your data into Assets, Expenses, Income and Liabilities 
among other things. 

4. Click the plus sign next to each item to see the sub-items. 

It is recommended to leave the folder structure in its default format until you are more familiar 
with the software.  Once you have become comfortable with Nominal, you can return to the 
Chart of Accounts and modify the structure to suit your needs.  To do this, click Manage, then 
Accounts. 



User Guide 

Nominal Accounting Software -13- 

5. Once you’ve familiarised yourself with the folder structure, click Next to proceed to Step 4, 
Registration.  Step 4 looks like this: 

 

6. This screen is automatically populated with information from Step 2.  Verify that the 
information is correct. 

7. Choose the appropriate option from the How did you hear of us? dropdown field. 

8. Click Continue. 
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After you click Continue, the Save As screen opens, prompting you to save your company files. 

 

9. Type a name for your company in the File name field. 

10. Click Save. 

The software saves your company data file and launches Nominal. 
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Product Areas (Tabs) 

Nominal is organised using a ribbon-interface similar to that found in Microsoft Office products. 

 

The Product Areas section of this guide provides an overview of the tabs available within 
Nominal.  The Product Areas section will discuss each of the tabs.  The tabs available in the 
software include: 

• File Menu 

o The File Menu section of this guide discusses the File Menu which provides 
access to Company Files related tasks. 

• Dashboard 

o The Dashboard section of this guide provides information related to the 
Dashboard tab of Nominal. 

• Sales 

o The Sales section of this guide covers sales-related functions including sales and 
services provided to customers, invoicing, payment management, quotes, 
refunds and accounts receivable management. 

• Bank 

o The Bank section of this guide includes using Nominal to record financial 
activities made with your bank accounts, not related to selling or purchasing 
items. 

• Books 

o The Books section of this guide includes information about using the Books tab 
to work with General Ledger entries. 

• Purchase 

o The Purchase section of this guide discusses Nominal as used to create purchase 
orders and manage payments to suppliers. 



Nominal Accounting Software 

 -16- September 2011 

• Manage 

o The Manage section of this guide discusses data management using Nominal.  
Data managed by Nominal includes:  accounts, suppliers, items, customer, 
employee and contacts lists. 

• Payroll 

o The Payroll section of this guide discusses using Nominal to manage the payroll 
function of your company. 

• Billing 

o The Billing section of this guide covers information related to the Billing tab of 
the software including time billed to clients for services rendered. 

• Report 

o The Report section of this guide discusses using the software to create reports 
that quickly and efficiently display data about your business. 

• SBR/ATO 

o The SBR/ATO section of this guide covers features found on the SBR/ATO tab of 
the software including BAS Submission, TFN Declaration and PAYG Summary. 

• Tools 

o  The Tools section of this guide discusses features found on the Tools tab of the 
software.  The Tools tab includes features that allow you to customise your 
software, check for updates and work with licensing. 

• Web 

o The Web section of this guide discusses features found on the Web tab of the 
software.  The Web tab includes features that allow you to work integrate 
Nominal with various online applications including PayPal, Freshbooks and 
Google. 

• Import 

o The Import section of this guide discusses features found on the Import tab of 
the software.  The Import tab includes features that allow you to import cards, 
items, accounts and transactions from various sources. 
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NOTE:  Depending on your license, you may have access to some or all of the tabs discussed in 
the following section. 
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File 

The File menu contains features related to company files.  The File menu looks like this: 

 

By default, the Details section of the File menu displays.  This area contains contact information 
for your company.  This information was completed in the New Company Wizard. 

The File Menu contains: 

• New 

o Click New to create a new company using the Company Wizard. 

• Open 

o Click Open to open an existing company file saved on your computer or network. 

• Save Copy 

o Click Save Copy to save a copy of the current file.  This can be used to create 
backup copies of your files. 
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• About 

o Click About to see the About screen, including software version. 
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• New Financial Year 

o Click New Financial Year to launch the Nominal end of financial year wizard. 

 

The Nominal end of financial year wizard will be discussed more in-depth later in this guide. 

• Exit 

o Click Exit and then Yes to the Exit the application screen that opens to exit the 
software. 
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Dashboard 

 

The Dashboard tab includes features used to organise your online life.  The table below 
describes the commands available on the Dashboard tab and the associated descriptions.  
Commands are listed by group, from left to right. 

Group Command Description 

Use 
 

Click View to view your business dashboard and get a better 
understanding of your business status. 

 

Click Add to add a portlet to the dashboard. 

Portlets 

Portlets are user interface components displayed in a web portal (dashboard).  Portlets are 
similar to widgets or small apps. 

Click the Add button to add a portlet to your dashboard.  Portlet choices include: 

• Debtor Days 

• Debtor Days Over Time 

• Buying Customers 

• Buying Customers Over Time 

• Average Sale 

• Average Sale Over Time 

• Top Creditors 

• Average Sale per Customer 
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• Average Sale per Customer Over Time 

• Creditor Days 

• Creditor Days Over Time 

• Sales Count 

• Sales Count Over Time 

• Top Debtors 

• Gross Profit 

• Gross Profit Over Time 

• Cash Flow 

• Customer Sales and Location 

• Profit per Product 

• Twitter Mentions 

• Twitter Followers 

• Twitter Followers over Time 

• Facebook Feed 

• Google Vistis 

• Google Goals 

• Google Ad Impressions 

• Google Ad Clicks 
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Sales 

 

The Sales tab includes features used to sell, invoice and analyse your transactions.  The table 
below lists the commands available on the Sales tab and the associated descriptions.  
Commands are listed by group, from left to right. 

Group Command Description 

Sell 

 

Click the Enter Sale button to create a new invoice.  The 
invoice opens in a new window, and an accompanying tutorial 
plays. 

 

Click the Receive Payment button to apply a customer 
payment to an open invoice.  Monies are moved from 
Accounts Receivable to the selected account.  The Receive 
Payment form opens in a new window, and an accompanying 
tutorial explains how to fill out the Receive Payment screen. 

 

Click the Apply Credit button to apply customer credit to an 
open invoice.  A customer credit is an invoice with a negative 
amount. 

 

Click the Create Quote button to create a new quote for sales 
or services for a customer.  Customer quotes can be created 
using several different templates. 

 

Click the Quote to Invoice button to convert an existing 
customer quote to an invoice. 
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Invoices 

 

Click Open to view the currently open invoices in the Invoice 
list. 

 

Click Close to view the currently closed invoices in the Invoice 
list. 

 

Click Credit to view the current credit invoices in the Invoice 
list. 

 

Click Quotes to view a list of all current quotes. 

Analyse 
 

Click Accounts Receivable to view the current outstanding 
customer invoices. 

 

Click Customer Statement to view and print a list of all unpaid 
invoices for select customers. 

Search 

 

Use the Search field and click the Advanced Search button to 
search for terms in the displayed fields. 
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Creating a Customer Invoice 

The Customer Invoice allows you to bill a client for bills or services.  A customer invoice looks 
like this: 
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The Customer Invoice screen has several sections and fields.  The sections and fields are 
outlined below. 

 Field Description 

1. Date The Date field displays the creation date of the invoice.  By default, this shows 
today’s date. 

2. ID The ID field displays the automatically created ID for the invoice.  Nominal 
automatically numbers invoices sequentially, beginning at 20000. 

3. Comment The Comment field can be used to display any comments associated with the 
invoice.  To add a comment, click in the field and type your comment. 

4. PO/Ref# 
The PO/Ref# field can be used to display the purchase order or reference 
number (if applicable) for the invoice.  To add a purchase order or reference 
number, click in the field and type the purchase order or reference number. 

5. Tax Inclusive Check the Tax Inclusive checkbox if the items in this invoice are taxable. 

6. Customer Choose the appropriate customer from the Customer dropdown or chose 
Quick Add from the list to add a new customer.  

7. Terms Choose the agreed upon terms from the Terms dropdown. 

8. Ship To 
The Ship To field displays the address associated with the customer selected in 
the Customer field.  Verify that the information is correct.  Click in the Ship To 
field to edit address information for this invoice. 

9. Due Date The Due Date displays the agreed upon due date as determined by the Terms.  
Click the Due Date dropdown to modify. 

10. Ship Date The Ship Date displays the date on which the customer’s shipment will ship.  
Choose the appropriate ship date from the Ship Date dropdown list. 

11. Line Items 
The Line Items display the items included on the customer invoice and the 
associated details including:  description, account, type, item, quantity, price, 
amount and tax code. 

12. Memo 
The Memo field is automatically filled in and will be included in the general 
ledger and generally follows the following format:  Invoice:Customer 
Name.  This Memo field can be edited.  Click in the field and type to edit. 

13. Job/Project/ 
Cost 

The Job/Project/Cost field allows you to associate different tags with this 
invoice to organise your data.  For example, you could create and add a Head 
Office Remodel tag to this invoice to group it with other invoices 
associated with this project. 

14. Attachment 

Click the Attachment button to scan and attach an electronic version of a 
hardcopy document or attach an electronic version of a document to the 
invoice.  For example, we could attach photos to the invoice displaying the 
items prior to shipment. 

15. Total (exTax), The Total (exTax) field displays the total cost of the items included on this 



Nominal Accounting Software 

 -28- September 2011 

Tax, Total invoice, before tax is applied. 
The Tax field displays the total tax calculated for the total cost of the items 
included on this invoice. 
The Total field displays the total invoice amount, which is the Total (exTax) + 
the Tax. 

16. Balance and 
Received 

The Balance field shows the total due to the customer for this invoice, minus 
any received amounts. 
The Received field shows any received amounts for this invoice. 

17. 
Pay Method 
and Pay 
Details 

Choose the appropriate Pay Method from the Pay Method dropdown.  Click 
the Pay Details button to enter the appropriate details (credit card number) 
for the selected Pay Method. 

18. Tutorial 
Controls 

Use the Stop, Play, Pause, Close (Current Voice Guide) and Close (ALL Voice 
Guides) buttons to control the tutorial associated with this screen. 

19. 

Template, 
Print, Email, 
Word and 
PDF 

Choose a template from the list to apply the selected template to your invoice. 
Click the Print button to print a copy of the invoice. 
Click the Email button to attach the invoice to an email. 
Click the Word button to create a Word version of the invoice. 
Click the PDF button to create a PDF version of the invoice. 

20. Save, Cancel 
and Shortcut 

Click Save to save the invoice. 
Click Cancel to close the invoice without saving. 
Click Shortcut to create a shortcut to this invoice. 
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Receiving a Payment 

After you have created an invoice and sent it to your customer, you should receive a payment 
from the customer for the invoice. 

To receive a payment, click the Receive Payment button on the Sales tab.  The Receive Payment 
screen opens. 

 

The Receive Payment screen has several fields that should be filled out to add as much 
information as possible to the software. 

  



Nominal Accounting Software 

 -30- September 2011 

The Receive Payment fields are described in the table below. 

 Field Description 

1. Deposit 
Account 

Select the appropriate deposit account from the Deposit Account dropdown.  
The Deposit Account dropdown list is comprised of accounts marked as 
Cheque in the master account list. 

2. Customer Select the appropriate customer from the Customer dropdown.  Once a 
customer is selected, a list of open invoices for that customer displays. 

3. Memo 
(Ledger) 

The Memo (Ledger) field is automatically filled in and will be included in the 
general ledger and generally follows the following format:  
Invoice:Customer Name.  This Memo field can be edited.  Click in the 
field and type to edit. 

4. ID The ID is automatically generated by Nominal and uniquely identifies this 
record. 

5. Date The Date field displays the date the payment was made.  By default, this is 
today’s date.  To change, click in the field and select another date. 

6. Open 
Invoice(s) 

The Open Invoice(s) area displays open invoices for the selected customer.  
• Each row displays a different invoice. 
• Each invoice has information organised in Date, Invoice ID, Sale 

Amount, Due Amount and Paid Today columns. 
Click in the Paid Today column for the appropriate invoice to enter the amount 
of the payment you are recording. 

7. 
Payment 
Method and 
Pay Details 

Choose the appropriate payment method from the Payment Method 
dropdown. 
Click the Pay Details button to enter payment details (credit card numbers) for 
the payment. 

8. Total Paid The Total Paid field displays the total of all the Paid Today column(s) above. 

9. Save Click Save to save and close the invoice. 

10. Cancel Click Cancel to close the invoice without saving it. 

Fill out the fields as accurately as possible to reflect the received payment. 
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Creating a Customer Quote 

A quote generally states a price for specific items or services rendered by a provider to a client.  
Quotes generally include a price, description of the items or services and a date. 

To create a quote, click the Create Quote button.  The Customer Quote screen looks like this: 
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 Field Description 

1. Date The Date field displays the date of the invoice.  By default this is today’s date.  
Click in the Date field to change the date. 

2. Customer Choose the appropriate customer from the Customer dropdown.  Choose 
Quick Add from the dropdown to add a new customer. 

3. Terms Choose the appropriate terms from the Terms dropdown.  Choose Quick Add 
from the dropdown to add a new term. 

4. Comment Type in the Comment field to associate a comment with this invoice. 

5. Ship To 
The Ship To field displays the address associated with the customer selected in 
the Customer field.  Verify that the information is correct.  Click in the Ship To 
field to edit address information for this invoice. 

6. ID The ID is automatically generated by Nominal and uniquely identifies this 
record. 

7. Tax Inclusive Check the Tax Inclusive checkbox if the items in this quote are taxable. 

8. Due Date The Due Date displays the agreed upon due date as determined by the Terms.  
Click the Due Date dropdown to modify. 

9. Ship Date The Ship Date displays the date on which the customer’s shipment will ship.  
Choose the appropriate ship date from the Ship Date dropdown list. 

10. Line Item(s) 

The Line Item(s), or rows, display an item or service included in the quote. 
Each Line Item is organised in columns and includes:  Description, Account, 
Type, Item, Quantity, Price, Amount and Tax Code columns. 
Fill out the information in each column for each Line Item. 

11. Tags 
Tags can be used to categorise the quote.  For example, maybe you’re working 
on several quotes for vendors at a festival.  To organise the quotes related to 
the festival, you could tag them, Hot Air Balloon Festival, 2011. 

12. Total (ex Tax) The Total (exTax) field displays the total cost of the items included on this 
invoice, before tax is applied. 

13. Tax The Tax field displays the total tax calculated for the total cost of the items 
included on this invoice. 

14. Total The Total field displays the total invoice amount, which is the Total (exTax) + 
the Tax. 

15. Template Choose a template from the list to apply the selected template to your invoice. 

16. 
Email, Print, 
Word and 
PDF 

Click the Print button to print a copy of the invoice. 
Click the Email button to attach the invoice to an email. 
Click the Word button to create a Word version of the invoice. 
Click the PDF button to create a PDF version of the invoice. 

17. Save Click the Save button to save the invoice. 
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18. Cancel Click the Cancel button to close the invoice without saving. 

19. Shortcut Click the Shortcut button to create a shortcut to this invoice. 
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Turning a Quote into a Sale 

To turn a quote into an invoice (sale), 

1. Click the Quotes button in the Invoices group of the Sales tab.  The invoice list displays 
below. 

 

2. Select the quote to turn into a sale by clicking the arrow on the far left of the row. 

3. Click Quote to Sale in the Sell group of the Sales tab.  The confirmation dialog box displays. 

 

4. Click Yes to confirm.  The new invoice opens, with associated tutorial, containing the 
information from the quote.  
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5. Click Dismiss to close the tutorial.  The customer invoice opens. 

 

6. Make any edits or actions necessary to the new invoice. 

7. Click Save.  The invoice is saved to the software. 
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Views 

Use the commands in the Invoices group of the Sales tab to filter the invoices displayed on your 
screen. 

• Click Open to view only open invoices. 

• Click Closed to view only closed invoices. 

• Click Credit to view only credit invoices. 

• Click Quotes to view only quotes (negative invoices). 
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Accounts Receivable 

The Accounts Receivable button located in the Analyze group of the Sales tab provides reports 
detailing the statuses of all unpaid invoices. 

To view an Accounts Receivable report,  

1. Click the Accounts Receivable button. 

 

The Accounts Receivable report opens showing all accounts with monies due. 

 

The summary table displays each customer in a row, with payment period data (debts <30, <60 
<90, and 90+ days old) organised by column.  
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Click in a cell to see details displayed below.  For example, I click the cell containing $178.40, 
and the following information displays: 

 

Notice that the Accounts Receivables by customer section of the screen notes the invoices 
included in the Accounts Receivables summary displayed above.  I can see that two invoices are 
currently open for the customer and the associated information. 

The Debt Collection slider is colour coded and provides a visual representation of the debt 
collection status for each selected item.  The Debt Collection slider is based on the amount of 
monies owed compared to the monies paid and the length of time the debt has been 
outstanding. 

  



User Guide 

Nominal Accounting Software -39- 

Customer Statement 

The Customer Statement button in the Analyze group of the Sales tab enables you to create a 
report listing unpaid invoices for any customer.  The report can then be emailed to a customer 
or printed. 

To create a customer statement, 

1. Click the Customer Statement button.  The Customer Statement screen, and associated 
tutorial, opens. 

2. Click Dismiss to close the tutorial. 

 

3. Select the desired customer by checking the box for the appropriate customer in the 
Selected column.  In our example, I’ve checked Lemondrop Sweet Shop. 
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4. Click Print to print the statement. 
-or- 
Click PDF to create a PDF of the statement. 
-or- 
Click Email to email the statement. 
-or- 
Click Word to create a Word version of the statement. 
In our example, I clicked PDF.  The statement is rendered to PDF and looks like this: 
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Searching 

The Search group enables you to quickly and easily search for things in Nominal.  For example, I 
want to see anything related to Lemondrop Sweet Shop.  I type Lemondrop in the Search field 
and press Enter.   

 

All of the entries in the software the criteria, in this case, contain the word Lemondrop, are 
displayed in a new Search screen. 

 

Double-click any of the entries in the Search screen to open the item. 

Use the Advanced Search button to place additional criteria on your search. 

NOTE:  The Search group of each tab functions similarly to the Search group found on the Sales 
tab.  Please refer to the previous section for help with the feature on any of the other tabs. 
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Bank 

 

The Bank tab includes features used to work with your money.  The table below lists the 
commands available on the Bank tab and the associated descriptions.  Commands are listed by 
group, from left to right. 

Group Command Description 

Money 

 

Click Spend Money to spend money from one of your bank 
accounts.  The Spend Money screen opens and a tutorial 
launches.  This is for spending not related to purchases. 

 

Click Receive Money to receive money into a bank account 
from selected accounts.  The Receive Money screen opens and 
a tutorial launches. 

 

Click Transfer Money to transfer money between your 
accounts.  The Transfer Funds screen opens and a tutorial 
launches. 

 

Click View Register to view a list of your deposits and 
withdrawals by bank account.  Choose the desired account 
from the dropdown list to see the transactions for that 
account. 

Banking 

 

Click Import Bank Transactions to launch a wizard to 
download a Quicken file from your bank to reconcile with your 
account transactions.  The Import Bank Statement screen 
opens and a tutorial launches. 
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Click EFT Batch Payments to launch a wizard to process your 
payments through an ABA file.   

Spending Money 

Click the Spend Money button to record money spent from a bank account towards an expense 
account.  This is for purchases not related to purchase orders.  Spend Money is used for money 
that has not been recorded through the purchase process.  This is common with items including 
parking, petrol, travel office supplies and other miscellaneous purchases. 
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 Field Description 

1. Withdrawal 
Account 

Choose the money account from which the funds will be withdrawn.  All 
accounts defined as Cheque display in this dropdown list. 

2. Existing Payee 
Choose the payee from the dropdown list.  If the payee is included in your 
contact cards, they will be included in this dropdown list.  If the payee is not in 
the list, use the Quick Add button to add the payee to the list. 

3. Payee Use the Payee field to enter descriptive text about the payee in the field above. 

4. Date The Date field displays today’s date by default.  Choose an alternate date if 
desired. 

5. Cheque/Ref. Type a cheque or reference number in the Cheque/Ref. field to keep track of 
this payment. 

6. ID The ID field displays the automatic ID number that Nominal has applied to this 
transaction. 

7. Line Item 
Line Items display information about the transaction including:   
Description (Note), Account, Amount and Tax Code.  See the Line Item section 
below for more information. 

8. Memo 
(Ledger) 

Enter any reference you would like to include with this item in the transaction 
journal in the Memo (Ledger) field. 

9. Job/Project/C
ost 

Type a tag, or choose an existing tag to apply to the Job/Project/Costs field by 
clicking the ellipses button.  Use this field to categorise your transactions. 

9. Attachment 
Click the Attachment button to attach an item to attach an item to this 
transaction in the transaction journal.  For example, scan a copy of a receipt for 
this transaction and attach it to this item using the Attachment button. 

10. Total (exTax) 
The Total (exTax) field displays a total of all line items excluding tax. 
Tax Inclusive:  Check the Tax Inclusive checkbox to include tax on each line 
item. 

11. Total Tax The Total Tax field displays a total of all line items including tax. 

12. Balance The Balance field displays the sum of the Total (exTax) and Total Tax fields. 

13. Save and 
Cancel 

Click Save to save this transaction.  Click Cancel to exit this transaction without 
saving. 

14. Shortcut Click the Shortcut button to create a shortcut for this transaction. 
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Line Item 
Each Line Item is organised by column.  The columns are: 

• Note 

o Type a description for the line item in the Note column. 

• Account 

o Type the account from which the transaction is payed in the Account column. 

• Amount 

o Type the amount of the transaction in the Amount column. 

• Tax Code 

o Choose the appropriate tax code for this column. 
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Receiving Money 

Use the Receive Money command to record money received into your accounts.  Use this 
feature to record moneys not related to customer sales.  This section is for instances in which 
you do not need to track customer payments and when payments are provided in full. 

• Tax amounts are recorded against GST received. 

• Amounts entered in each line are attributed to the selected income amount. 

• The total amount is added from the selected bank account. 
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 Field Description 

1. Deposit 
Account Choose the money account from which the funds will be deposited. 

2. Existing Payee 
Choose the payee from the dropdown list.  If the payee is included in your 
contact cards, they will display in this dropdown list.  If the payee is not in the 
list, use the Quick Add button to add the payee to the list. 

3. Payee Use the Payee field to enter descriptive text about the payee in the field above. 

4. Date The Date field displays today’s date by default.  Choose an alternate date if 
desired. 

5. Cheque/Ref. Type a cheque or reference number in the Cheque/Ref. field to keep track of 
this payment. 

6. ID The ID field displays the automatic ID number that Nominal has applied to this 
transaction. 

7. Line Item 
Line items display information about the transaction including:  description 
(Note), Account, Amount and Tax Code.  See the Line Item section below for 
more information. 

8. Memo 
(Ledger) 

Enter any reference you would like to include with this item in the transaction 
journal in the Memo (Ledger) field. 

9. Job/Project/C
ost 

Type a tag, or choose an existing tag to apply to the Job/Project/Costs field by 
clicking the ellipses button.  Use this field to categorise your transactions. 

10. Attachment 
Click the Attachment button to attach an item to attach an item to this 
transaction in the transaction journal.  For example, scan a copy of a receipt for 
this transaction and attach it to this item using the Attachment button. 

11. Total (exTax) 
The Total (exTax) field displays a total of all line items excluding tax. 
Tax Inclusive:  Check the Tax Inclusive checkbox to include tax on each line 
item. 

12. Total Tax The Total Tax field displays a total of all line items including tax. 

13. Balance The Balance field displays the sum of the Total (exTax) and Total Tax fields. 

14. Save Click Save to save this transaction. 

15. Cancel Click Cancel to exit this transaction without saving. 

16. Shortcut Click the Shortcut button to create a shortcut for this transaction. 
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Transferring Money 

Use the Transfer Money feature to move money between your accounts.  Transfer Money 
creates a withdraw record in one account and a deposit record in another. 

 

 Field Description 

1. Withdrawal 
Account Choose the account from which you would like to withdraw money. 

2. Deposit 
Account Choose the account in which you would like to deposit the withdrawal. 

3. Memo 
(Ledger) Type a note to accompany this transaction in the transaction journal. 

4. ID The ID is automatically assigned to the transaction record by Nominal. 

5. Date The Date field automatically displays today’s date by default.  Change this 
entry if necessary. 

6. Amount Type the amount of the transfer in the Amount field. 

7. Reference The Reference is automatically generated by Nominal and assigned to the 
transaction record so that it is easily catalogued.  

8. Save and 
Close 

Click Save to save the transaction record. 
Click Cancel to close this transaction record without saving. 
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Viewing the Register 

Click the View Register button to view all deposits and withdrawals.  Choose the desired 
account from the Account Transactions dropdown. 

 

Use the From, To and Range fields to view the desired transactions. 

Use the Delete, Edit, Copy, Paste and Duplicate buttons to work with the displayed line items. 

Each line item displays a different transaction, with information organised by column.   
Double-click an entry to see more detail about the line item. 

Importing Bank Transactions 

Click the Import Bank Transactions button to import a Quicken file downloaded from your bank 
to reconcile the bank transactions with those recorded by Nominal. 

To import bank transactions from your institution, 

1. Click the Import Bank Transactions button.  The Import Bank Statement screen opens. 

2. Click the Load button to browse to and import a Quicken (QIF) file saved to your computer 
or network.  The QIF file uploads to the software. 

Matching 
Once you’ve imported the QIF from your bank, you can begin reconciling your bank information 
with the information stored in Nominal. 

Click the Match button to load a list of transactions in the left side of the table (from the QIF) 
and tries to match each transaction in the left side of the table with an account transaction 
(Nominal) on the right side of the table. 
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Matches are made if: 

• Amount and Date are the same in both lists. 

Possible matches are made if: 

• The Amount and Date are within 7 days in both sides of the table. 

Items can be matched by dragging them from the right side of the list to the left side of the list. 

 Option Description 

 Apply Applies the changes to the matched transactions. 

 Close Closes the current window. 

 Clear Clears the matching for the selected transaction. 

 Ignore Ignores the selected transaction. 

 Ignore All Ignores all unmatched transactions. 

 Enter Registry Creates a registry item for the selected bank transaction. 

EFT Batch Payments 

Use the EFT Batch Payments button to launch a wizard that processes your payments through 
an ABA file.  You can also generate a file containing all EFT transactions and execute them with 
your bank.  Use the EFT Batch Payments button to generate an ABA file for the selected 
transactions. 
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Books 

 

The Books tab contains commands used for working with the General Ledger.  The table below 
lists the commands available on the Books tab and the associated descriptions.  Commands are 
listed by group, from left to right. 

Group Command Description 

General Ledger 

 

Click Enter Record to enter a general ledger transaction.  Enter 
Record can be used for credits and debits, and enters 
transactions directly into the general ledger.  A minimum of 
two line items are required for a general ledger transaction.  
The total credit and debit must balance out.  Transactions 
shouldn’t generally be added to the general ledger. 

 
Click the Returns button to view a list of items related to 
returns. 

 
Click the Invoices button to view a list of transactions related 
to invoices. 

 
Click the Credits Applied button to view a list of items related 
to credits. 

 
Click the General button to view a list of general ledger 
transactions. 

 
Click the Payments Received button to view a list of payments 
received. 

 
Click the Payments Made button to view a list of payments 
made. 

 
Click the Purchases button to view a list of items related to 
payments. 

 
Click the Receive Money button to view a list of items related 
to receiving money. 

 
Click the Spend Money button to view a list of items related to 
spending money. 

 
Click the Transfer Money button to view a list of items related 
to transferring money. 
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Click the Payroll button to view items related to payroll. 

General Ledger Record 

Click the Enter Record button to open a new general ledger record. 

Use a general ledger record to enter transactions which are not related to invoices, purchases, 
spending or deposits. 
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 Field Description 

1. Date By default, the Date field displays today’s date.  If desired, change to a 
different date. 

2. Memo Type a description for the general ledger item in the Memo field. 

3. Ref The Ref field displays a reference number for the general ledger item.  This is 
automatically assigned to the entry by Nominal. 

4. ID The ID field displays the ID for the general ledger item.  This is automatically 
assigned to the entry by Nominal. 

5. Line Item 
Line items display the credit and debit for the general ledger item.  Choose the 
account in the Account field.  The credit and debit must balance each other 
out. 

6. Total Debit The total debit displays the total for all debits in the general ledger item.  It is 
automatically calculated. 

7. Job/Project/C
ost 

If the general ledger item is related to a particular job, project or cost, enter 
the job, project or cost information in the field. 

8. Total Credit The total credit displays the total for all credits in the general ledger item.  It is 
automatically calculated. 

9. Balance The balance displays the difference between the total debits and total credits.  
The balance must be zero before the general ledger entry can be saved. 

10. Save and 
Cancel 

Click Save to save the general ledger item to the general ledger.  The balance 
must be zero to save the general ledger item.  Click Cancel to exit the ledger 
without saving the item. 

Journal Records 

The following options allow you to view a list of journal transactions, organised by type.  Each 
journal transaction is associated with a source, such as an invoice or payment. 

• Returns 

o Click the Returns button to view records related to returns. 

• Invoices 

o Click the Invoices button to view records related to invoices. 

• Credits Applied 

o Click the Credits Applied button to view records related to credits applied. 
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• General 

o Click General to view a list of all general ledger records. 

• Payments Received 

o Click Payments Received to view a list of all records related to payments 
received. 

• Payments Made 

o Click Payments Made to view a list of all records related to payments made. 

• Purchase Order 

o Click Purchase Order to view all records related to purchase orders. 

• Receive Money 

o Click Receive Money to view all records related to monies received. 

• Spend Money 

o Click Spend Money to view all records related to spending money. 
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Purchases 

 

The Purchases tab is used to manage business purchases, items or services.  It can also be used 
for items being sold, tracking inventory and for services and other items with outstanding 
payments. 

If payment is made in full, or supplier payments do not need to be tracked, then Spend Money 
may be used instead of Purchases. 

Group Command Description 

Purchase 
 

Click Enter Purchase to enter an order for a supplier.  Use this 
option to order new products or services. 

 

Click Pay Supplier to pay open invoices. 

Purchases 

 

Click Open to view a list of purchases with outstanding 
balances. 

 

Click Closed to view a list of purchases that have been fully 
paid. 

 

Click All to view a list of all open and closed purchases. 

Analyze 

 

Click Accounts Payable to view a list of outstanding purchases. 
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Enter Purchases 

Click Enter Purchase to open the Purchase (Purchase Order) screen.  This screen is used to 
record supplier invoices, pay a supplier for an item or purchase received and to email or print 
the purchase. 

At least one supplier must be defined in your supplier list prior to using this function. 

 

 Field Description 

1. Date The Date field is automatically populated with today’s date.  Click in the field 
and type an alternate date if desired. 

2. Supplier Choose the appropriate supplier from the Supplier dropdown. 

3. Terms The Terms field defaults to 30 days.  Chose another term or click Quick Add to 
apply different terms. 

4. ID The ID is automatically applied by Nominal and is used by the software to keep 
track of this transaction. 

5. Comment Click in the Comment field to add a comment to this record. 

6. Ship To Ship To defaults to your shipping address.  Click in the field to enter an 
alternate address if desired. 



User Guide 

Nominal Accounting Software -57- 

7. Tax Inclusive Check the Tax Inclusive box if this item is taxable. 

8. Due Date The Due Date defaults to 30 days from the date of the purchase.  Click to 
change the entry to another date if desired. 

9. Ship Date The Ship Date defaults to today’s date.  Click to change the entry to another 
date if desired. 

10. Line Item 
Enter the details for this item in the line item area.  Each line item is organised 
in columns.  Columns include:  Description, Account, Type, Item, Quantity, 
Price, Amount and Tax Code. 

11. Memo 
(Ledger) 

The Memo (Ledger) field displays how this entry will be identified in the 
General Ledger.  Click to change. 

12. Job/Project/C
ost Enter an associated Job/Project/Cost if desired. 

13. Attachment Click the Attachment button to add an attachment such as a scanned receipt. 

14. Pay Method 
Choose the appropriate method of payment from the Pay Method dropdown.  
Click Quick Add if the appropriate entry is not on the list.  Click the Pay Details 
button to add information about any credit card entries. 

15. 

Total (ex Tax) 
Tax 
Total 
Paid 
Balance 

The Total (ex Tax), Tax, Total, Paid and Balance fields are populated using the 
information entered in the line item.  If an amount has been paid on this item, 
type that information in the Paid field. 

16. Template If desired, choose a template from the Template dropdown. 

17. 
Send 
Print 
Preview 

Click Send to send a copy of this invoice via email. 
Click Print to print a copy of this invoice. 
Click Preview (PDF) or Preview (Word) to preview this item in the associated 
application. 

18. Save 
Cancel 

Click Save to save this item to the General Ledger. 
Click Cancel to close this item without saving it to the General Ledger. 

19. Shortcut Click Shortcut to create a shortcut to this item. 

• Line Item 

o Line Items are organised by column.  Each column requires specific information. 

• Description 

o Enter a description for this purchase order item, or select a previous description 
from the dropdown list.  If choosing an item from the dropdown list, the other 
columns will be automatically populated. 
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• Account 

o Select an income account to record this purchase order item against, or click 
Quick Add to add a new account. 

• Type 

o Purchase order items can be items, services or other.  Items are predefined and 
have purchase prices.  They can be tracked for inventory.  A service is predefined 
and has a price and type.  Other only has an associated price. 

• Item 

o Select the item from the list, or use Quick Add to add a new item. 

• Quantity 

o Type the appropriate quantity. 

• Price 

o The price for each item. 

• Amount 

o The total amount (Price x Quantity). 

• Tax Code 

o Select the relevant tax code from the dropdown list, or add the correct code. 
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Pay Supplier 

The Pay Supplier function is used to pay open purchase orders.  Funds are added to Accounts 
Payable and are reduced from the selected bank account.  Click the Pay Supplier button to 
open the Pay Supplier screen. 
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 Field Description 

1. Deposit 
Account 

Select the account from which the funds are to be withdrawn.  The list of 
accounts is generated from accounts marked as Cheque in the Master 
Account List. 

2. Supplier 
Select the supplier to be paid from the Supplier dropdown list.  Once a supplier 
is selected, the open purchase orders for that supplier are displayed in the line 
items area. 

3. Memo 
(Ledger) 

The Memo (Leger) field displays text used to identify this item in the General 
Ledger.  Click in the field and type alternate text if desired. 

4. Date The Date defaults to today’s date.  Click in the field and choose an alternate 
date if desired. 

5. Paid Type the total paid to the supplier in the Paid field. 

6. ID The ID is automatically assigned by Nominal and is used by the software to 
keep track of the item. 

7. Line Item Each Line Item is an open purchase order for the selected supplier. 

8. Total Paid The Total Paid field displays the totals of all Paid cells for the open purchase 
orders for the selected supplier. 

9. Save 
Cancel 

Click Save to save this item. 
Click Cancel to close this item without saving. 
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Purchase Orders List 

• Click Open to view all open purchase orders.  Open purchase orders are purchase orders 
that have an outstanding balance. 

• Click Closed to view all closed purchase orders.  Closed purchase orders are purchase 
orders that have been paid in full. 

• Click All to view all, open and closed, purchase orders. 

 

 Field Description 

1. Export Click Export to export purchases to Excel. 

2. Print Click Print to print the purchases grid. 

3. From The From field displays the starting date for the range of purchases displayed 
in the grid. 

4. To The To field displays the ending date for the range of purchases displayed in 
the grid. 

5. Range The Range field displays the range used to display the purchases in the grid. 

6. Delete Click Delete to delete a purchase order. 

7. Edit Click Edit to edit a purchase order. 

8. Copy Click Copy to copy a purchase order. 

9. Paste Click Paste to paste a purchase order. 
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Accounts Payable 

Click Accounts Payable in the Analyze group to review outstanding purchase orders and to view 
a summary of all outstanding purchases. 

 

The Accounts Payable screen displays the current outstanding amounts for each supplier.  The 
table is organised by supplier (row) and dates (columns). Each cell displays a summary of the 
outstanding purchase order. 
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Click in a row or cell to view a list of purchase orders in the summary table below. 

 

The Debt Collection slider is a visual representation of outstanding supplier payments.  The 
information is calculated based on amounts owed vs. amounts paid as well as the length of 
time since the payment was due. 
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Manage 

 

The Manage tab contains commands used for working with and managing your company 
information.  The table below lists the commands available on the Manage tab and the 
associated descriptions.  Commands are listed by group, from left to right. 

Group Command Description 

Accounts 

 

Click the Accounts button to manage your Chart of Accounts.  
Use Axccounts to manage company accounts; add, edit or 
delete accounts; set the account balance for each account. 

Items 

 

Click the Items button to manage the list of items and services 
used by the company.  Use Items to define items or services 
the company is selling and billing for.  Use Items to define 
items or services the company is purchasing or billed for. 

Manage Lists 

 

Click the Tax Codes button to manage the list of tax codes.  
Use Tax Codes to add, edit or delete tax codes and rates. 

 

Click the Terms button to manage the list of sales terms.  Use 
Terms to add, edit or delete payment terms for invoices and 
purchases. 

 

Click the Pay Methods button to manage the list of payment 
methods.  Use Pay Methods to add, edit or delete methods of 
payment. 

 

Click the Leave Types button to manage payroll leave types.  
Use Leave Types to define whether leave is accrued, how many 
hours per year, and whether the leave is paid and/or visible on 
the payslip. 

Manage Cards 

 

Click the All Cards button to manage a list of all card types.  
Use All Cards to add, edit and/or delete customers, employees, 
suppliers and personal card types. 
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Click the Customers button to manage a list of customer cards.  
Add, edit and/or delete customers. 

 

Click the Employees button to manage the list of employees.  
Add, edit or delete employees. 

 

Click the Suppliers button to manage the list of suppliers.  Add, 
edit or delete suppliers. 

 

Click the Personal button to manage the list of personal 
contacts.  Add, edit or delete personal contacts. 

Chart of Accounts 

Click the Accounts button to manage your Chart of Accounts.  Use the Chart of Accounts to add 
new accounts, delete unused accounts or to edit account details. 

The Chart of Accounts displays information in two different ways. 

• The left part of the screen displays a tree displaying all accounts in the proper hierarchy. 

• The right part of the screen displays accounts in a table. 
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Editing Tools 
The Account list management section of the screen contains tools related to editing accounts.  
Use the editing tools to add, delete, print grid contents, edit account information and reload 
account information into the tree. 

Table Display 
The Table Display organises your accounts into a table format for easy viewing. 

The Table Display provides the following information about each account: 

• Account ID  

o Nominal’s unique identifier used to identify the account within the software. 

• Account Parent 

o The account’s parent, or account above this account in the hierarchy. 

• Account Name  

o The common name used to describe the account. 

• Account Type 

o Describes the account type.  Types include:  container (folder) account, detail 
(leaf) account, or special purpose (accounts receivable, accounts payable, super 
payable, GSTpayable, etc.). 

• Account Group 

o Defines the main group the account is contained in.  Groups include:  ROOT, 
ASSET, EQUITY, EXPENSE, etc. 

• Account Balance 

o Displays the current balance in the account. 

• BAS Field 

o Displays information about the associated business activity statement. 

Tree Display 
The Tree Display organises your accounts into a tree format displaying the accounts in a 
hierarchy. 
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Items 

Click the Items button to manage your items for sale, or items for your purchase.  Items can be 
added, edited or deleted. 

 

• Items, Services or Rates Management 

o Use the buttons in the Items, Services or Rates Management section of the 
screen to export and/or print the Items grid, or add or delete items from the list. 

• Item ID 

o The Item ID column displays the unique identifier for the item. 

• Name 

o The name of the item. 

• Code 

o A tag used to categorise the line item. 

• Type 

o Displays Item or Service. 

• Selling/Billing? 

o Displays a checkmark if you are selling and billing for this item. 

• Sell/Bill Price 

o Displays the price for this item. 

• Buying/Paying? 

o Displays a checkmark if you are buying and paying for this item. 
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• Buy/Pay Price 

o Displays the price for this item. 

Tax Codes 

Click the Tax Codes button to add, edit or delete tax codes and rates. 

 

Manage list of tax codes and rates 
Use the buttons in the Manage list of tax codes and rates section of the screen to export and/or 
print the Tax Code grid, or add or delete tax codes and rates from the list. 
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Terms 

Click the Terms button to add, edit or delete terms for invoices and purchases. 

 

Terms Management 
Use the buttons in the Terms Management section of the screen to export and/or print the 
Terms grid, or add or delete terms from the list. 

Manage Cards 

The Manage Cards group contains commands used to manage all card types.  Card types 
include customers, suppliers, employees and personal contacts. 

Click All Cards to view a list of all card types. 
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Cards contain the same information regardless of card type.  The table below describes each 
piece of information. 

Field Description 

ID Automatically generated by Nominal.  Used by the software to identify this 
card. 

Name The card’s name.  Can be the name of a person, company or other 
organisation. 

Type The card’s type.  Types include:  Employee, Customer, Supplier or Personal. 

Phone Main phone number for the card. 

Alt Phone Alternate phone number for the card. 

Fax Fax number for the card. 

Email Email address for the card. 

Website Website for the card. 

Contact Contact person related to this card. 

Alt Contact Alternate contact person related to this card. 

Location Click the Address Details button to add multiple addresses related to this card.  
For example, shipping, billing and home address. 
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Employee Details 

In addition to fields common to all cards, as described in the section above, employee cards 
have employment details.  Click the Payroll Details button on the Employee Contact card to 
access the employee details. 
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Personal 

Field Description 

Employee ID The employee’s identification number.  This is automatically assigned by Nominal 
and is used by the software to identify the employee. 

Date of Birth Enter the employee’s date of birth. 

Marital Status Choose the employee’s marital status from the dropdown list.  Choices include, 
Married, Single and Divorced. 

Gender Choose Male or Female from the dropdown list. 

Employment 

Field Description 

Hire Date Choose the employee’s hire date. 

Date Leaving Choose the employee’s termination date if known. 

Employment Choose the type of employment from the dropdown list.  Choices include:  Full Time, 
Part Time, Casual and Temporary. 

Job Title Type the employee’s job title in the field. 

Department Type the employee’s department in the field. 

Manager Select the employee’s manager from the dropdown list. 

Payroll 

Field Description 

Timesheet or 
Salary 

Choose the appropriate radio button for the type of employment.  If Salary is 
selected, choose the appropriate Wages Type from the dropdown list, and the enter 
the wages figure. 

Leave Rate Enter the employee’s leave rate. 

Pay Frequency Choose the appropriate pay frequently.  Choices include:  Weekly, Fortnightly, and 
Monthly. 

Bank Name Enter the employee’s bank name.  For direct deposit. 

Name Enter the employee’s name.  For direct deposit. 

Number Enter the employee’s account number.  For direct deposit. 

BSB Enter the employee’s BSB number.  For direct deposit. 
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Taxes & Super 

Field Description 

Tax Scale The tax scale is defined by the ATO and is used to calculate the PAYG withholding. 

HELP Check if HELP is relevant to this employee. 

SFSS Check if SFSS is relevant to this employee. 

Tax File Number Enter the employee’s tax file number. 

Super Rate The default and minimum is 9%.  Adjust accordingly. 

Fund Name Name of the superannuation fund for the employee. 

Fund Number Member number for the employee’s superannuation fund. 
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Payroll 

 

The Payroll tab is used to manage payroll.  Use the functions on the Payroll tab to manage pay 
runs and payslips for the company.  Use the tab to create, print and email payslips for 
employees.  Use the Payroll tab to record payments made to and on behalf of employees.  The 
table below lists the commands available on the Payroll tab and the associated descriptions.  
Commands are listed by group, from left to right. 

Group Command Description 

Employee 

 

Click the Employees button to manage the Employee list.  Add 
edit or delete employees from the list.  This provides access to 
the same area of the software as Manage | Cards | Employees. 

Salaries 

 

Click the Pay Run button to access the Payroll Management 
screen. 

 

Click the Tax Calculator button to open the Tax Calculator. 

 

Click the Record Leave button to manage the list of leave 
records.  Add, edit or delete employee leave from the list. 

Payroll Management 

The Payroll Management screen enables you to manage pay-cycles for your employees, and to 
define related pay slips for each pay-cycle.  A pay-cycle will be auto generated by the system 
when the current date is after the last pay cycle end.  

The type of pay-cycle created (weekly, fortnightly or monthly) will be dependent on the kind of 
pay-cycle your employees are defined as.  When there are only weekly paid employees in the 
system, the system will only create weekly pay-cycles.  The same is true for fortnightly and 
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monthly employees.  If there are only employees of one type in your system, only pay-cycles of 
that type will be created.  You can also manually create pay-cycles using the plus button. 

When a pay-cycle is created, the relevant payslips are created for each employee with the same 
pay-cycle type, all weekly employees will be added to a new weekly pay-cycle.  You are able to 
add or delete employees to a pay-cycle using the plus and minus buttons on the table below. 

When employees’ pay slips are created the different payroll details are calculated automatically 
by the system based on the employee payroll details and the pay-cycle type.  For example, a 
weekly base salary will be based on calculating the yearly salary, etc.  Other deductions such as 
superannuation will be calculated based on the employee’s details and in the payroll section of 
their employee card. 

Use the Pay Run button to open the journal and enter the appropriate records for payment of 
selected pay cycle.  Please note that once a payment is made, no changes can be made to a pay 
cycle or journal.  You may use the general journal to enter reconciliation records at a later time. 

 

Manage Company’s Pay Run 
Use the options in the Manage Company’s Pay Run section to add, delete, pay, print or email 
payroll entries.  Filter the date range for the Pay Runs displayed in the table using the From, To, 
and Range fields. 

The top section of the screen displays Pay Cycle information. 

The bottom section of the screen displays Pay Slip information. 
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Tax Calculator 

The Tax Withholding Calculator is used to calculate TAX withholdings for employees’ wages 
based on information from the TAX Office, July, 1 2010 (NAT1004). 

 

• Tax Scale 

o Select the relevant ATO tax scale for the current employee. 

• HELP 

o Check the HELP checkbox if it is relevant to this employee. 

• SFSS 

o Check the SFSS checkbox if it is relevant to this employee. 

• SCEP 

o Check the SCEP checkbox if it is relevant to this employee. 

• Weekly 

o The Weekly field displays the amount withheld based on the entered 
information using the Calc button. 

• Calc 

o Click the Calc button to calculate the Weekly amount. 
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Billing 

 

 

The Billing tab contains features used to deal with billing clients for time worked on their 
projects or for recording hourly employees’ time.  The table below lists the commands available 
on the Payroll tab and the associated descriptions.  Commands are listed by group, from left to 
right. 

Group Command Description 

Timesheet/Billing 
 

Click the Time Sheets button to enter timesheets for 
employees working on customer tasks to record hours for 
billing.  Also can be used to calculate non-salaried employees’ 
salaries. 

 

Click Bill Time to bill your customers for time recorded in 
timesheets.  Select the hours performed for the selected 
customer and create an invoice. 
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Timesheet 

Click the Time Sheets button to enter timesheet information for employees providing work for 
clients. 

 

To create a timesheet choose the appropriate employee from the Employee dropdown.  Choose 
the appropriate dates in the Time Sheet for fields. 

Create a line item for each task performed by the employee.  Each column contains different 
information about the task. 

• Service/Rate 

o Choose the desired Service/Rate from the dropdown menu, or use Quick Add to 
add a service or rate that is not in the list. 

• Customer 

o Choose the desired customer from the dropdown menu, or use Quick Add to 
add a new customer not in the list. 

• Task 

o Type the task in the task cell.  This is a description that will be provided on the 
invoice. 
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• Days 

o Type the hours worked for each day of the week.  The hours are totalled in the 
Total field. 

• Invoice 

o Click Invoice to create a new invoice based on the information entered in the 
time sheet. 

• Apply 

o Click Apply to total the hours in the timesheet. 

• Close 

o Click Close to close the timesheet without saving. 

• Copy Last 

o Click Copy Last to copy the last entry in the timesheet to a new row. 

• Delete 

o Click Delete to delete the timesheet. 
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Bill Time 

Once time has been entered for an employee or multiple employees, an invoice can be created 
to bill a client for time worked. 
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To create an invoice for a customer, choose the desired customer from the Customer 
dropdown.  Check the desired timesheets using the checkbox in the Selected column.  Click 
Invoices.  An invoice is created. 
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Report 

 

The Report tab provides access to several different report types.  To view a report, access the 
desired report type from the Ribbon, and the report displays.  The table below lists the 
commands available on the Payroll tab and the associated descriptions.  Commands are listed 
by group, from left to right. 

Group Command Description 

Reports 

 

The Accounts dropdown provides access to: 
• Accounts List 
• Account Transactions 
• Journal Summary 
• Journal Detail 

 

The Journal dropdown provides access to: 
• General Journal 
• Disbursement 
• Receipt 

 

The Banking dropdown provides access to: 
• Bank Register 
• Deposits 
• Withdrawal 
• Bank Balance 

 

The Sales dropdown provides access to: 
• Item Sales 
• All Sales 
• Closed Invoices 
• Open Invoices 
• Quotes 
• Credits 
• Reconcile Receivables 
• Reconcile Payables 



Nominal Accounting Software 

 -84- September 2011 

 

The Lists dropdown provides access to: 
• Card List 
• Card Locations 
• Card Transactions 
• Price List 

 

The Job/Cost dropdown provides access to: 
• Job Transactions 
• Jobs Incoming 
• Jobs Outgoing 

 

The GST dropdown provides access to: 
• GST Cash 
• GST Accrual 

Snapshot 

 

Click Balance Sheet to view a snapshot of the Balance Sheet.  
Use the tools at the top of the screen to filter the report. 

 

Click Profit and Loss to view a snapshot of profits and losses.  
Use the tools at the top of the screen to filter the report. 

 

Click Trial Balance to use the Trial Balance tool.  Use the tools 
at the top of the screen to filter the results. 

 

Click Cash Flow to view a graphical representation of Bank 
Inflow vs. Outflow.  Use the tools at the top of the screen to 
filter the report. 

Charts 

 

The Income/Expense dropdown provides access to: 
• Total Balances 
• Income by Account 
• Expenses by Account 
• Withdraw by Payee 
• Income Trend 
• Expenses Trend 
• Income vs. Expenses 
• Account Trend 



User Guide 

Nominal Accounting Software -85- 

 

The Asset/Liability dropdown provides access to: 
• Asset Accounts 
• Liability Accounts 
• Asset Trend 
• Liability Trend 
• Asset vs. Liability 
• Bank Account Trend 

 

The Items/Services dropdown provides access to: 
• Sales Types 
• Item Sales 
• Item Purchases 

 

The Sales/Purchases dropdown provides access to: 
• Sale by Customer 
• Purchase by Supplier 

 

The Staff dropdown provides access to: 
• Org Chart 
• Staff Report 
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SBR/ATO 

The SBR/ATO tab provides access to the Standard Business Reporting group.  The Standard 
Business Reporting group contains three commands: 

• BAS Submission 

• TFN Declaration 

• PAYG Summary 

BAS Submission 

Click the BAS Submission button to launch the Business Activity Statement wizard. 
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 Field Description 

1. Load Click Load to load the AusKey file received from the ABR.  This is used to 
identify your business to the ATO. 

2. Start Period Select the appropriate start date for the period from the Start Period 
dropdown. 

3. End Period Select the appropriate end date for the period from the End Period dropdown. 

4. Password Enter your AusKey password for the BAS. 

5. Company ABN Type the appropriate company ABN in the field. 

6. Validate Key 
After loading the AusKey, selecting the appropriate ABN, choosing the date 
range and entering your AusKey password, click the Validate Key button to 
validate the entered information. 

7. List (1) Click the tab to switch to the List tab.  Click Go to execute the List operation. 

8. Prefill (2) Click the tab to switch to the Prefill tab.  Click Go to execute the Prefill 
operation. 

9. Prelodge (3) Click the tab to switch to the Prelodge tab.  Click Go to execute the Prelodge 
operation. 

10. Lodge (4) Click the tab to switch to the Lodge tab.  Click Go to execute the Lodge 
operation. 

11. Reporting 
Party Type the appropriate information for the reporting party into the fields. 

12. Select 
Statement Choose the desired statement template from the dropdown list. 

13. Statement Fill in the Statement fields as appropriate. 

To submit a BAS, 

1. Click the List tab to view the List tab.  Fill out the fields within the tab. 

2. Click Go. 

3. Click Load.  This loads the AusKey file received from the ABR, which is used to identify your 
business to the ATO.  The information from the AusKey file displays in the ABN List, 
immediately to the right of the Load button. 

4. Choose your company ABN from the ABN list. 

5. Click the Prefill tab.  Fill out the fields within the tab. 

6. Click Go. 
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7. Click the Prelodge tab.  Fill out the fields within the tab. 

8. Click Go. 

9. Choose the desired Start Period and End Period. 

10. Type your AusKey password in the Password field. 

11. Click Validate Key.  Your details are validated and the wizard completes your Business 
Activity Statement. 

TFN Declaration 

Click the TFN Declaration button to launch the TFN Declaration Wizard. 

 

Section A:  Payee 

 Field Description 

1. Load and TFN 
List 

Click the Load button to load an XML file containing your AusKey credentials. 
Choose the correct credentials from the TFN List. 

2. 
Start Period Select or type the appropriate start date for the period from the Start Period 

dropdown. 

End Period Select or type the appropriate end date for the period from the End Period 
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dropdown. 

3. Password Enter your AusKey password for the BAS. 

4. Company ABN Type the appropriate company ABN in the field. 

5. Apply Click Apply to set your username and verify your password. 

6. 
Pre Lodge TFN Click Pre Lodge TFN to submit the Pre Lodge TFND service. 

Lodge TFN Click Lodge TFN to submit the Lodge TFND. 

7. List of 
Employees 

Click the List of Employees dropdown to select an employee from the list.  This 
list is created from the card list. 

8. Load Click Load to load the list of employees created from the card list. 

9. 
What is your 
tax file 
number? 

Type your tax number.  Tax numbers are unique numbers issued by the Tax 
Office to individuals and organisations to identify tax records.  It increases 
efficiencies in administering tax and other Australian Government systems. 
If you are unable to report a tax number for an individual, choose the reason 
from the TFN Exemption dropdown. 

10. What is your 
Name? 

Family Name:  The payee’s previous surname, where the payee has on the 
declaration provided a name by which they were previously known to the ATO. 
Given Name:  The payee’s previous first name, where the payee has on the 
declaration provided a name by which they were previously known to the ATO. 
Other Given Name:  The payee’s previous second given name, where the payee 
has on the declaration provided a name by which they were previously known 
to the ATO.  

11. What is your 
Date of birth? Choose the date of birth for the payee. 

12. 
What is your 
home Address 
in Australia? 

The payee’s home address in Australia.  If the payee lives overseas, check the 
Overseas Address checkbox. 

13. On what basis 
are you paid? 

Choose the correct option describing the payment arrangement between the 
payer and payee. 

14. 

Are you an 
Australian 
resident for 
tax purposes? 

If the payee is an Australian resident for tax purposes check the checkbox. 

15. 

Do you want 
to claim your 
tax free 
threshold for 
this payer? 

The tax-free threshold is the amount of income that can be earned each year 
that is not taxed; this threshold can vary each year.  This is only available to 
Australian residents. 

16. Do you want 
to claim the 

Indicates an offset allowing eligible people to earn more income before they 
have to pay tax and the Medicare levy has been requested.  If a taxpayer is 
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senior 
Australians 
tax offset? 

eligible this means they pay less tax.  To be eligible a taxpayer must meet four 
conditions: 
1) Age 
2) Eligibility for Australian Government age pensions or similar payments 
3) Taxable income threshold, and 
4) Not in gaol. 
If the taxpayer meets all four conditions, the amount of offset will vary 
depending on their taxable income and circumstances. 

17. 

Do you want 
to claim a 
zone, 
overseas 
dependant 
spouse or 
special tax? 

Zone:  A Zone offset may be claimed by a taxpayer if they live or work in 
certain remote areas of Australia. 
Overseas Forces:  If a taxpayer serves as a member of Australia’s Defence Force 
or United Nations armed forces, he is eligible for the Overseas Forces tax 
offset. 
Dependant Spouse:  The Dependant Spouse Tax Offset is available to taxpayers 
who contribute to the maintenance of their dependant spouse which reduces 
the amount of tax to be paid. 
Invalid Relative:  A person may be entitled to a special tax offset for a 
dependant invalid relative, dependant parent, housekeeper caring for an 
invalid spouse or a dependant child-housekeeper. 

18. 

Do you have 
accumulated 
Financial 
Supplement 
debt? 

Check the checkbox if the taxpayer has a Student Financial Supplement 
Scheme. 

Do you have 
accumulated 
Higher 
Education 
Loan Program 
(HELP) debt? 

Check the checkbox if the taxpayer has a Higher Education Loan Program 
benefit in place. 

19. Declaration 

Declaration Type:  Choose Payee Signature Present if a hardcopy of the 
reported record has been signed. 
Accepted:  Check the Accepted checkbox to show that the declaration has 
been accepted. 
Signature:  Enter the Supplier Signatory Identifier Text. 
Date:  Choose the date of the declaration. 

20. 
Timestamps 
Messages 

If applicable Timestamps and/or Messages will display in this area. 
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Section B:  Payer 

Most of the information in the Section B: Payer tab will be automatically populated with 
information from other areas in the software. 

 

 Field Description 

1. 

What is your 
Australian 
business 
number (ABN) 
or your 
withholding 
number? 

Your ABN is a unique identified used by the ATO on behalf of the Tax Agent’s 
Board.  It is used to uniquely identify individuals registered by the Tax Agent’s 
Board. 

2. 

What is your 
registered 
business 
name or 
trading 
name? 

Report the trading name of the payer in full.  If the payer does not have a 
trading name, leave this field blank. 

3. Declaration 
by Payer 

Declaration Type:  Choose Payer Signature Present if a hardcopy of the 
reported record has been signed. 
Accepted:  Check the Accepted checkbox to show that the declaration has been 
accepted. 
Signature:  Enter the Supplier Signatory Identifier Text. 
Date:  Choose the date of the declaration. 

4. What is your 
business 

Your business address should be automatically populated by Nominal.  Make 
any adjustments necessary. 
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address? 

5. 
Who is your 
contact 
person? 

The Payer Contact Name is to be reported in full with one space between 
words and also any initials that occur in the name.  The field cannot be blank. 

Complete the fields outlined above to submit the TFN declaration. 

PAYG Summary 

Click the PAYG Summary button to launch the PAYG Summary Wizard. 

 

Section A:  Payee 

 Field Description 

1. 
Load 
TFN List 

Click the Load button to load an XML file containing your AusKey credentials. 
Choose the correct credentials from the TFN List. 

2. 
Start Period 
End Period 

Select or type the appropriate start date for the period from the Start Period 
dropdown. 
Select or type the appropriate end date for the period from the End Period 
dropdown. 

3. Password Enter your AusKey password for the BAS. 

4. Company ABN Type the appropriate company ABN in the field. 
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5. Apply Click Apply to set your username and verify your password. 

6. 
Pre Lodge 
PAYG Click Pre Lodge TFN to submit the Pre Lodge TFND service. 

Lodge PAYG Click Lodge TFN to submit the Lodge TFND. 

7. List of 
Employees 

Click the List of Employees dropdown to select an employee from the list.  This 
list is created from the card list. 

8. Load Click Load to load the list of employees created from the card list. 

9. 
What is your 
tax file 
number? 

Type your tax number.  Tax numbers are unique numbers issued by the Tax 
Office to individuals and organisations to identify tax records.  It increases 
efficiencies in administering tax and other Australian Government systems. 
If you are unable to report a tax number for an individual, choose the reason 
from the TFN Exemption dropdown. 

10. What is your 
Name? 

Family Name:  The payee’s previous surname, where the payee has on the 
declaration provided a name by which they were previously known to the ATO. 
Given Name:  The payee’s previous first name, where the payee has on the 
declaration provided a name by which they were previously known to the ATO. 
Other Given Name:  The payee’s previous second given name, where the payee 
has on the declaration provided a name by which they were previously known 
to the ATO.  

11. What is your 
Date of birth? Choose the date of birth for the payee. 

12. 
What is your 
home Address 
in Australia? 

The payee’s home address in Australia.  If the payee lives overseas, check the 
Overseas Address checkbox. 

13. 

Withholding 
Payment 
Income Type 

Choose the code indicating the type of income being reported in the payment 
summary. 

Period Start 
Date Choose the appropriate period start date. 

Period End 
Date Choose the appropriate period end date. 

Pay As You Go 
Tax 
Withholding 
Tax Withheld 

Enter any income tax withheld under the Pay As You Go Arrangement. 

Individual 
Non Business 
Gross 

Enter any payments of salary, wages, bonuses and commissions paid to the 
payee as an employee, company director or office holder.  Include the total 
gross amount before amounts are withheld for tax. 

Additional Click the dropdown to enter any additional details about the payee’s 
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Details withholdings. 

Report 
Amendment 
Indicator 

Check the checkbox if this report contains amended data. 

Section B: Payer 

Most of the information in the Section B: Payer tab will be automatically populated with 
information from other areas in the software. 
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 Field Description 

1. 

What is your 
Australian 
business 
number (ABN) 
or your 
withholding 
number? 

Your ABN is a unique identified used by the ATO on behalf of the Tax Agent’s 
Board.  It is used to uniquely identify individuals registered by the Tax Agent’s 
Board. 

2. 

What is your 
registered 
business 
name or 
trading 
name? 

Report the trading name of the payer in full.  If the payer does not have a 
trading name, leave this field blank. 

3. Declaration 
by Payer 

Declaration Type:  Choose Payer Signature Present if a hardcopy of the 
reported record has been signed. 
Accepted:  Check the Accepted checkbox to show that the declaration has 
been accepted. 
Signature:  Enter the Supplier Signatory Identifier Text. 
Date:  Choose the date of the declaration. 

4. 
What is your 
business 
address? 

Your business address should be automatically populated by Nominal.  Make 
any adjustments necessary. 

5. 
Who is your 
contact 
person? 

The Payer Contact Name is to be reported in full with one space between 
words and also any initials that occur in the name.  The field cannot be blank. 

Complete the fields outlined above to submit the TFN declaration. 
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Tools 

 

The Tools tab provides access to several preferences and software-related functions.  The table 
below lists the commands available on the Tools tab and the associated descriptions.  
Commands are listed by group, from left to right. 

Group Command Description 

Settings 

 

Click the Change button to access Preferences and change 
various settings within the software. 

License 

 

Click the Activate Paid License button to validate your 
payment and activate your software license.  Please make sure 
to enter the same email addressed used when making the 
purchase. 

 

Click the Extend Trial button to extend your trial period by one 
month.  Enter the appropriate details to extend your license. 

 

Click Buy Now to purchase Nominal Accounting Software.  
Click this button to be taken to your PayPal account to 
purchase the software. 

Update 
 

Click the Check For Updates button to verify that the latest 
version of the software is installed.  If it is not installed, the 
newest version can be downloaded. 

 

Click the Win/Donate $200 button to fill out a survey about 
the software.   
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Web 

 

The Web tab provides access to integration-related functions.  Use the commands available in 
the Integrate group to integrate Nominal with many online services.  The table below lists the 
commands available on the Web tab and the associated descriptions.  Commands are listed by 
group, from left to right. 

Group Command Description 

Integrate 

 

Click the PayPal Transactions button to download transactions 
from your PayPal account, and create account records.  You 
will need your PayPal API account information including 
username, password and signature.  A corresponding Nominal 
Register record will be created for each PayPal transaction 
once configured. 

 

Click the Import Cards dropdown to import contact cards from 
the following sources: 

• PayPal 
• Magneto 
• VirtueMart 
• Zen Cart 

 

Click the Import Items dropdown to import items from the 
following sources: 

• Magneto 
• VirtueMart 
• Zen Cart 

 

Click the Freshbooks button to connect to your Freshbooks 
account using the Freshbooks API and import your Freshbooks 
clients, invoices, expenses and items.  Obtain your Freshbooks 
API URL and authentication token here:  Freshbooks | My 
Accounts | Freshbooks API. 

 

Click the Harvest button to connect to your Harvest account 
using the Harvest API to import your data into Nominal.  
Obtain your Harvest domain, username/email and password 
here:  https://<domain>.harvestapp.com. 
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Click the SalesForce button to connect to your SalesForce 
account using the Web Service API to import your data into 
Nominal.  Obtain your SalesForce username, password and 
token here:  Name | Setup | My Personal Information | Reset 
my security token.  Note:  You will need API access to your 
account. 

 

Click the SugarCrm button to connect to your SugarCRM 
instance using the Web Service API and import your data into 
Nominal.  Obtain your SugarCRM username, password and 
URL. 

 

Click the Highrise button to connect to your Highrise account 
using the Highrise API to import your data into Nominal.  
Obtain your Highrise domain, username/email and password 
here:  https://<domain>.highrisehq.com. 

 

Click the Google button to connect to your Google account 
using the Google Contacts API and import your contacts into 
Nominal.  Obtain your Google username/email and password 
to connect to your Google account. 
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Import 

 

The Import tab provides access to importing functions.  Use the commands available in the 
Import group to import data from various sources.  The table below lists the commands 
available on the Import tab and the associated descriptions.  Commands are listed by group, 
from left to right. 

Group Command Description 

Import 

 

Click the Import Cards dropdown to import the following 
cards: 

• Outlook Contacts 
• QuickBooks Contacts 
• Cashflow Cards 
• MYOB Cards 

 

Click the Import Items dropdown to import the following 
items: 

• QuickBooks Items 
• Nominal Items 
• Cashflow Items 
• MYOB Items 

 

Click the Import Accounts dropdown to import your MYOB 
account. 

 

Click the Import Transactions dropdown to import Nominal 
Excel files. 
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Reference 

The Reference section contains details about emailing and printing fields, keyboard shortcuts 
and other detailed information. 
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Email and Print 

Nominal uses Microsoft Office automation for printing and emailing invoices, purchase orders, 
quotes and pay slips. 

Nominal uses Microsoft Word templates (.dot and .dotx) to create versatile templates for your 
records.  Customising the built-in templates is as easy as working in a Word document.  You can 
add your company logo, header, comments or any other text or graphics. 

To customise a template, copy the template you would like to modify from the Nominal 
software folder, edit as desired and save back to the Nominal software folder.  Simple as that! 

In Nominal, each record contains different fields.  For example, a pay slip contains the salary 
and tax fields while a quote contains sales items. 

See the following sections for a list of fields available for each type of record. 
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Invoice Fields 

When editing an invoice template, you can use any of the fields below.  You must use the exact 
field name. 

[0] [type, Card Info] 

[1] [invoiceid, Sale Record] 

[2] [card, Sale Record] 

[3] [terms, Sale Record] 

[4] [shipping, Sale Record] 

[5] [invoiceDate, Sale Record] 

[6] [dueDate, Sale Record] 

[7] [shipDate, Sale Record] 

[8] [customerPO, Sale Record] 

[9] [comment, Sale Record] 

[10] [freight, Sale Record] 

[11] [glmemo, Sale Record] 

[12] [paymethod, Sale Record] 

[13] [paydetails, Sale Record] 

[14] [totalDue, Sale Record] 

[15] [totalPaid, Sale Record] 

[16] [tags, Sale Record] 

[17] [totalExTax, Sale Record] 

[18] [totalTax, Sale Record] 

[19] [desc, Sale Item] 

[20] [account, Sale Item] 

[21] [item, Sale Item] 
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[22] [quantity, Sale Item] 

[23] [price, Sale Item] 

[24] [amount, Sale Item] 

[25] [taxCode, Sale Item] 

[26] [id, Card Info] 

[27] [name, Card Info] 

[28] [phone, Card Info] 

[29] [altphone, Card Info] 

[30] [fax, Card Info] 

[31] [email, Card Info] 

[32] [website, Card Info] 

[33] [contact, Card Info] 

[34] [altcontact, Card Info] 

[35] [Notes, Card Info] 

[36] [Photo, Card Info] 

[37] [companyName, Company Info] 

[38] [companyABN, Company Info] 

[39] [companyAddress1, Company Info] 

[40] [companyAddress2, Company Info] 

[41] [companyCity, Company Info] 

[42] [companyState, Company Info] 

[43] [companyPostCode, Company Info] 

[44] [companyCountry, Company Info] 

[45] [phoneNumber, Company Info] 
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[46] [faxNumber, Company Info] 

[47] [emailAddress, Company Info] 

[48] [webSite, Company Info] 
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Purchase Fields 

When editing a purchase order template you can use any of the following fields.  You must use 
the exact field name. 

[0] [id, Card Info] 

[1] [card, Purchase Record] 

[2] [terms, Purchase Record] 

[3] [shipping, Purchase Record] 

[4] [purchaseDate, Purchase Record] 

[5] [dueDate, Purchase Record] 

[6] [shipDate, Purchase Record] 

[7] [comment, Purchase Record] 

[8] [freight, Purchase Record] 

[9] [glmemo, Purchase Record] 

[10] [paymethod, Purchase Record] 

[11] [paydetails, Purchase Record] 

[12] [totalDue, Purchase Record] 

[13] [totalPaid, Purchase Record] 

[14] [tags, Purchase Record] 

[15] [totalExTax, Purchase Record] 

[16] [totalTax, Purchase Record] 

[17] [desc, Purchase Item] 

[18] [account, Purchase Item] 

[19] [type, Card Info] 

[20] [item, Purchase Item] 

[21] [quantity, Purchase Item] 
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[22] [price, Purchase Item] 

[23] [amount, Purchase Item] 

[24] [taxCode, Purchase Item] 

[25] [name, Card Info] 

[26] [phone, Card Info] 

[27] [altphone, Card Info] 

[28] [fax, Card Info] 

[29] [email, Card Info] 

[30] [website, Card Info] 

[31] [contact, Card Info] 

[32] [altcontact, Card Info] 

[33] [Notes, Card Info] 

[34] [Photo, Card Info] 

[35] [companyName, Company Info] 

[36] [companyABN, Company Info] 

[37] [companyAddress1, Company Info] 

[38] [companyAddress2, Company Info] 

[39] [companyCity, Company Info] 

[40] [companyState, Company Info] 

[41] [companyPostCode, Company Info] 

[42] [companyCountry, Company Info] 

[43] [phoneNumber, Company Info] 

[44] [faxNumber, Company Info] 

[45] [emailAddress, Company Info] 
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[46] [webSite, Company Info] 
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Quote Fields 

When editing a quote template you can use any of the following fields.  You must use the exact 
field names. 

[0] [type, Card Info] 

[1] [invoiceid, Quote Record] 

[2] [card, Quote Record] 

[3] [terms, Quote Record] 

[4] [shipping, Quote Record] 

[5] [invoiceDate, Quote Record] 

[6] [dueDate, Quote Record] 

[7] [shipDate, Quote Record] 

[8] [customerPO, Quote Record] 

[9] [comment, Quote Record] 

[10] [freight, Quote Record] 

[11] [glmemo, Quote Record] 

[12] [paymethod, Quote Record] 

[13] [paydetails, Quote Record] 

[14] [totalDue, Quote Record] 

[15] [totalPaid, Quote Record] 

[16] [tags, Quote Record] 

[17] [totalExTax, Quote Record] 

[18] [totalTax, Quote Record] 

[19] [desc, Quote Item] 

[20] [account, Quote Item] 

[21] [item, Quote Item] 
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[22] [quantity, Quote Item] 

[23] [price, Quote Item] 

[24] [amount, Quote Item] 

[25] [taxCode, Quote Item] 

[26] [id, Card Info] 

[27] [name, Card Info] 

[28] [phone, Card Info] 

[29] [altphone, Card Info] 

[30] [fax, Card Info] 

[31] [email, Card Info] 

[32] [website, Card Info] 

[33] [contact, Card Info] 

[34] [altcontact, Card Info] 

[35] [Notes, Card Info] 

[36] [Photo, Card Info] 

[37] [companyName, Company Info] 

[38] [companyABN, Company Info] 

[39] [companyAddress1, Company Info] 

[40] [companyAddress2, Company Info] 

[41] [companyCity, Company Info] 

[42] [companyState, Company Info] 

[43] [companyPostCode, Company Info] 

[44] [companyCountry, Company Info] 

[45] [phoneNumber, Company Info] 
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[46] [faxNumber, Company Info] 

[47] [emailAddress, Company Info] 

[48] [webSite, Company Info] 

  



User Guide 

Nominal Accounting Software -111- 

Pay Slip Fields 

When editing a pay slip field, you can use any of the following fields.  You must use the exact 
field name. 

[0] [cycleId, 1] 

[1] [cardId, 0] 

[2] [cardName, 0] 

[3] [Base, 0] 

[4] [Super, 0] 

[5] [BeforeAddition, 0] 

[6] [BeforeDeduction, 0] 

[7] [Gross, 0] 

[8] [Tax, 0] 

[9] [AfterAddition, 0] 

[10] [AfterDeduction, 0] 

[11] [NetPay, 0] 

[12] [type, 1] 

[13] [fromDate, 1] 

[14] [toDate, 1] 

[15] [payDate, 1] 

[16] [totalPaid, 1] 

[17] [totalPayg, 1] 

[18] [totalSuper, 1] 

[19] [totalPreAddition, 1] 

[20] [totalPreDeduction, 1] 

[21] [totalPostAddition, 1] 
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[22] [totalPostDeduction, 1] 

[23] [textEmpId, 2] 

[24] [textDepartment, 2] 

[25] [textTitle, 2] 

[26] [textBank, 2] 

[27] [textAcName, 2] 

[28] [textAcNumber, 2] 

[29] [textAcBSB, 2] 

[30] [textWagesFigure, 2] 

[31] [textTFN, 2] 

[32] [textSuperRate, 2] 

[33] [textSuperName, 2] 

[34] [textSuperMember, 2] 

[35] [dateDOB, 2] 

[36] [dateHire, 2] 

[37] [dateLeaving, 2] 

[38] [cbMartial, 2] 

[39] [cbGender, 2] 

[40] [cbManager, 2] 

[41] [cbEmployment, 2] 

[42] [cbWageType, 2] 

[43] [cbPayFrequency, 2] 

[44] [cbWagesAccount, 2] 

[45] [cbTaxScale, 2] 
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[46] [isHELP, 2] 

[47] [isCDEP, 2] 

[48] [isSFSS, 2] 

[49] [DependencyObjectType, 2] 

[50] [IsSealed, 2] 

[51] [Dispatcher, 2] 

[52] [companyName, 3] 

[53] [companyABN, 3] 

[54] [companyAddress1, 3] 

[55] [companyAddress2, 3] 

[56] [companyCity, 3] 

[57] [companyState, 3] 

[58] [companyPostCode, 3] 

[59] [companyCountry, 3] 

[60] [phoneNumber, 3] 

[61] [faxNumber, 3] 

[62] [emailAddress, 3] 

[63] [webSite, 3] 
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Keyboard Shortcuts 

Shortcut Description 

I + Ctrl New Invoice 

O + Ctrl New Order 

S + Ctrl New Spend 

R + Ctrl New Receive 

P + Ctrl New Payment 

B + Ctrl New Pay Supplier 

G + Ctrl New General Ledger 

T + Ctrl New Apply Credit 

W + Ctrl New BAS Wizard 

+ Date one day forward. 

- Date one day back. 

 


